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Microsemi makes no warranty, representation, or guarantee regarding the information contained
herein or the suitability of its products and services for any particular purpose, nor does
Microsemi assume any liability whatsoever arising out of the application or use of any product or
circuit. The products sold hereunder and any other products sold by Microsemi have been
subject to limited testing and should not be used in conjunction with mission-critical equipment
or applications. Any performance specifications are believed to be reliable but are not verified,
and Buyer must conduct and complete all performance and other testing of the products, alone
and together with, or installed in, any end-products. Buyer shall not rely on any data and
performance specifications or parameters provided by Microsemi. It is the Buyer’s responsibility
to independently determine suitability of any products and to test and verify the same. The
information provided by Microsemi hereunder is provided “as is, where is” and with all faults,
and the entire risk associated with such information is entirely with the Buyer. Microsemi does
not grant, explicitly or implicitly, to any party any patent rights, licenses, or any other IP rights,
whether with regard to such information itself or anything described by such information.
Information provided in this document is proprietary to Microsemi, and Microsemi reserves the
right to make any changes to the information in this document or to any products and services
at any time without notice.

About Microsemi

Microsemi Corporation (NASDAQ: MSCC) offers a comprehensive portfolio of semiconductor
and system solutions for aerospace & defense, communications, data center and industrial
markets. Products include high-performance and radiation-hardened analog mixed-signal
integrated circuits, FPGAs, SoCs and ASICs; power management products; timing and
synchronization devices and precise time solutions, setting the world's standard for time; voice
processing devices; RF solutions; discrete components; enterprise storage and communication
solutions; security technologies and scalable anti-tamper products; Ethernet solutions; Power-
over-Ethernet ICs and midspans; as well as custom design capabilities and services. Microsemi
is headquartered in Aliso Viejo, California, and has approximately 4,800 employees globally.
Learn more at www.microsemi.com.
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Introduction to FlashPro Express

About

About

FlashPro Express

FlashPro Express is Microsemi’s programming software tool designed from the ground up to address secured
programming assurance in production programming house environments. FlashPro Express software supports
PolarFire ™, SmartFusion®2, IGLOO®2, and RTG4™ in the Windows and Linux OS environments, using the
FlashPro Programmer hardware.

You can install FlashPro Express two ways:

e Integrated with Libero - FlashPro Express is installed automatically when Libero is installed. FlashPro
Express is used by Libero to perform the programming tasks for PolarFire, SmartFusion2, IGLOO2, and
RTG4, as part of the design flow.

e Stand-Alone - FlashPro Express is also available as a standalone installation. This mode is primarily used
for production programming or lab programming on machines in which a full version of Libero is not
required.

See the Microsemi website for more information on FlashPro Express.

FlashPro Programmer

The FlashPro series of hardware programmers saves you board space because a single JTAG chain can be used
for all JTAG devices. In-system programming using the JTAG port adds the flexibility of field upgrades or post-
assembly production-line characterization. Production costs are significantly reduced as a result of elimination of
expensive sockets on the board.

See programmer sections and the Microsemi website for details on FlashPro3/X, FlashPro4, FlashPro5 and
FlashPro6.

Note: FlashPro 5 and FlashPro 6 support programming though the device SPI Slave port as well.

Secure Job Programming

Job programming is the concept of using a single file to program a Microsemi device or chain of Microsemi
devices using encrypted bitstreams.

The single job file contains all of the information necessary to setup FlashPro Express as well as the encrypted
bitstream images for the devices in the job. Once a job file is created it can be handed off securely to production
programming houses or contract engineering facilities to load the Microsemi images during manufacturing. Job
projects can be exported from Libero and imported into stand-alone FlashPro Express providing a clean
delineation between design flow and production programming.

Migrating FlashPro Projects to FlashPro Express

Existing FlashPro projects (*.pro) files are now called Job Project files in FlashPro Express. These Job Projects
can be opened with FlashPro Express to take advantage of Linux programming support and the simplified tool
targeted for operators in a production floor environment.

FlashPro projects that were created in single mode will not be supported with this tool. Microsemi recommends
that you convert these projects to chain mode projects. To convert the project to a chain project, do the following
steps:

1. Open the FlashPro project (*.pro) in FlashPro.

2. Locate the loaded STAPL file by one of two methods:

The log will print “STAPL file ‘<stapl_path>" has been loaded successfully.” <stapl_path> is the location of
the STAPL file loaded.
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xl Software Version: 11.5.0.15

5Ta file 'D:\cest project\projectData\topdefavic.scp® has been loaded successfully.
DESIGH : top: CHECKSUM : F673; ALG VERSION : 2

[ F T\ Al L Erors , warmings ), info |

Within the Single Device Configuration Window there is a field STAPL_FILE_NAME, which displays
the location of the STAPL file loaded.

x| Programming file

3
topdefault.stp ?

" I

DATE MODIFIED Wed Oct 2% 15:-20:-25 2014
STAPL. FILE MAME D:“\test projecti\projectData’topdefault_st|
CREARTOR FlashPro Version: wll_4
DEVICE MZ5050T =
| & FACERAEZE M25050T-fg4B84
9| |paTtE 2014706718
= STADPL. VERSION JESDT1 F—
5 IDCODE OF80Z1CF
w| |IDMASE OFFEFFFF
o |pEsTewW top |
E THECECSTT TaT2
o 1| 1 | »
g )
@
(] [ Chain Parameter... Inspect Device
1]
2
£
o

3. Switch the project to chain mode by one of the two methods:
a. Press the chain button from the toolbar.

|

b. From the Tools menu, select Mode->Chain Programming.
4. Load the STAPL file in chain mode by adding a Microsemi device in the chain.
a. From the File menu, select Configuration->Add Microsemi Devices from Files.
b. Browse to the location of the STAPL file and clickOpen.
5. To save the project, from the File menu, select Save Project.
6. You may now open the project using FlashPro Express.
When moving FlashPro project (*.pro) files to another machine, Microsemi recommends that you archive the
entire project folder, copy it to the new machine, extract it locally, then load the job project within FlashPro

Express. FlashPro Express will only open a job project if a programmer is connected to the machine, at least one
Microsemi device has programmed enabled, and all enabled Microsemi devices have a bitstream file loaded.
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Supported Families - FlashPro Express

The table below lists the device families and their derivatives that FlashPro Express can program directly through
Libero or by exporting a FlashPro Express job:

Table 1 - Product Families and Derivatives Directly Supported by FlashPro Express

Device Family Family Description
Derivatives
PolarFire N/A Lowest power, cost optimized, mid-range solution
SmartFusion2 N/A Address fundamental requirements for advanced security, high

reliability and low power in critical industrial, military, aviation,
communications and medical applications.

IGLOO2 N/A Low-power mixed-signal programmable solution

RTG4 N/A Radiation-tolerant programmable solution

Installing FlashPro Express Software and Hardware

See the Microsemi Website for more information about FlashPro Express.



https://www.microsemi.com/products/fpga-soc/fpga/polarfire-fpga
https://www.microsemi.com/products/fpga-soc/soc-fpga/smartfusion2
https://www.microsemi.com/products/fpga-soc/fpga/igloo2-fpga
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Getting Started

Starting FlashPro Express

Start FlashPro Express by running the program at [installation folder] > bin > FPExpress.

FlashPro Express Interface

The main FlashPro Express Ul consists of a list of programmers and a chain table, as shown in the figure below.
This view displays the programmers connected to the machine, and the devices within the JTAG chain specified
in the job project file (PRO) file, as shown in the figure below.

Note: For SmartFusion2 and IGLOO2 devices, you have the option to select JTAG or SPI Slave in the Select
Programming Interface dialog box. See the Select Programming Interface help topic in the online help for more
information.

e Hover over the programmer Info icon to display more information about a programmer.

e Click the Name field to change a programmer name.

e Click the checkbox to enable or disable a programmer.

¢ Right-click a programmer to Ping, Self-Test, Scan, Check Chain or Remove it from the list.

e Additional information about a device and programming file, if loaded, can be viewed by hovering over the
info icon of that device.

e Devices specified as disabled in the job project (*.pro) file are shown disabled and their HighZ value is
displayed in the column header.

e Device/Programmer States:
e |DLE: The devices/programmers are idle and not executing any programming action.
e DISABLED: Devices that are not enabled for programming
e PASSED: The last programming operation passed
e FAILED: The last programming operation failed
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Figure 1 - FlashPro Express Programmers and Chain Table (JTAG example)
Note: SPI Slave mode is supported by FlashPro5 for SmartFusion2 and IGLOO2 devices, and by FlashPro6 for

SmartFusion2, IGLOO2, and PolarFire devices. JTAG is the default interface.

Project Edit View Prog

rammer Help

@ FlashPro Express E\sd1_spi_slave\sd1_spi_slave.pro - SPI Slave Programming Interface

[E=8 B =3

Refresh/Rescan Programmers

Programmer

@ so

M25150TS

]

DI 2

1| @V [sd002

IDLE

IDLE

RUN

PROGRAM - ‘

IDLE

Log

(E) Messages € Errors i, Warnings @ Info

Software Version:

12.500.0.14

FlashPro4

PDB_VERSION :

PDB_VERSION :

Created FlashPro Express Job Project.

1.0

1.0

PPD file 'E:\sdl_spi_slave\sdl_spi_slave.ppd' has been loaded successfully.
DESIGN : sdl; CHECKSUM : 7E87;
creating folder: E:\adl_spi_slave\projectData

PED file 'E:\sdl_spi_slave\sdl spi_slave.ppd' has been loaded successfully.
DESIGN : sdi; CHECRSUM : 7EB7;
Driver : 3.0.0 build 1

programmer '84093" :

2

Figure 2 - FlashPro Express Programmers and Chain Table (SPI Slave example)

Note: RTG4 devices do not support SPI Slave programming.
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Creating a Job Project from a FlashPro Express Job

Once you are ready to hand off your design for production you can create a job project. To do so:

1. InLibero run Export FlashPro Express Job to create a container that will be used to transfer programming
configuration information, including programming files, to the production programming tool FlashPro
Express.

Design settings
Programming options set with the Configure Programming Options tool:

Design version -0 Back Level version - 0

Security options set with the Configure Security tool:
Encrypt bitstream with default key. Mo user keys or security settings are enabled.
FlashPro Express Job file

Configured device chain with bitstream files and programmer settings will be incduded in the programming job.

MName: |h3|: Location: |D:\Designs_Proj'w12_2'|,ex1'|,designer'|,b3p'|,export

Existing files:

This folder is empty.

Program {IJTAG programming interface):
¥ Design

I spiFlash i

Design bitstream file format: |PFD (*.ppd) ~| i@

Design bitstream file type:

| Fabric/sMNVM |

File to program at trusted facility v

Zeroization actions:
[ Like Mew (Erases all user data; device can be immediately reprogrammed by user)

[ Unrecoverable (Erases all data and destroys reprogrammability; device must be scrapped)

Help oK | Cancel |

Figure 3 - Export FlashPro Express Job

2. In FlashPro Express, from the Project menu choose New Job Project From FlashPro Express Job. You
will be prompted to specify the Programming Job File location that you just exported from Libero and the
location of where to store the FlashPro Express Job Project. The Job Project name automatically uses the
programming job name and cannot be changed. Click OK and a new Job Project will be created and opened
for production programming.
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New Job Project from FlashPro Express Job

Programming job file:

-Isnft;fsqatestQfsnu.thardfprnj_ull_ﬂ.;fs_d;fd esigner;fsnrt_dfexpnrt.jsort_d.jnb

FlashPro Express job project name:
0 sort_4

FlashPro Express job project location:

-Isnft;fsqatestQfsnu.thardfprnj_ull_ﬂ.;fs_dfrpx

(=

Figure 4 - New Job Project from FlashPro Express Job Dialog Box

Load a Job Project

To get started in FlashPro Express you must load a job project (*.pro file). To do so, from the Project menu
choose Open Job Project. A job project will open if:

e Atleast 1 programmer is connected
e Atleast 1 Microsemi device is enabled for programming
e Any enabled Microsemi device for programming must have a bitstream fileloaded
To open a project:
1. From the Project menu, choose Open Job Project. The Open Project dialog boxappears.

2. Find your project file or type in your project file name in the File namefield.
3. Click Open.

10
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[ FlashPro Express =

Project Edit View Programmer Help

Job Projects

Lreate,,
open...

Recent Projects

=] Messages | €3 Emors iy Wamings ) Info

Figure 5 - FlashPro Express Launch Screen

Saving a Job Project

Click the Save button on the toolbar, or from the Project menu choose Save Job Project to save your project.

Programming Tutorials

Parallel Programming with FlashPro5/4/3/3X

Parallel programming enables you to program multiple Microsemi devices in parallel with multiple programmers.
In parallel programming, all targeted devices are programmed with the same programming file (STAPL). The
targeted device or chain configuration that is connected to each programmer must be identical.

The FlashPro Express software together with the FlashPro5/4/3/3X programmers supports parallel programming
via a USB port. You can connect up to sixteen FlashPro5/4/3/3X's to a PC via a USB v1.1 or a USB v2.0 port.
FlashPro5/4/3/3X requires a self-powered hub.

Connecting FlashPro5/4/3/3X (a USB v2.0 enabled programmer) to USB v1.1 port increases device programming
time due to a slow data transfer rate on the USB v1.1 port in comparison to a USB v2.0 port.

The following figure illustrates how you can connect a FlashPro5/4/3/3X programmer for parallel programming.

11
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Figure 6 - Connecting a FlashPro5/4/3/3X Programmer

An independent thread processes the STAPL file during parallel programming. In an Microsemi test, parallel
programming is approximately five times faster than programming 16 devices sequentially.

Note: Microsemi has tested Belkin PCI-USB cards and hubs. We have found that parallel programming
works best with the vendor's latest driver installed and with the matching hubs.

Chain Programming Tutorial

This tutorial demonstrates how to use FlashPro Express to program a multi-device, multi-programmer chain. This
tutorial uses the production programming flow that exports a programming job from Libero SoC, which includes
chain configuration, programmer settings, and bitstream files for programming, and creates a job project from a
programming job.

The figure below shows the chain used in this tutorial. M2S050T is device 1 and A3P250 is device 3. Device 1 is
the first device to be programmed in the chain and device 2 is the last; device 3 is disabled and will not be
programmed.

E FlashPro Express  CAl\FPecpress_Tutorial\FPexpress_projectitest/test.pra

Project  Edit  View Prograrmrer  Help

| Refresh/Rescan Programmers |
(1] mzsosoT R awElson ) AIPZ50
[Programamer
STp0 ToI GTD0 TG G ToO HhZ O TDIG
1 (@M oesse IDLE IDLE IDLE DISABLED
z B9 sz IDLE ICLE DLE DISABLED

Figure 7 - Chain Programming Devices
To program a chain:
1. From the Project menu, choose New Job Project from FlashPro Express Job.

2. Click Browse to load a Programming Job File, and specify your FlashPro Express job project location.
Click OK to continue, as shown in the figure below.

12
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New Job Project from FlashPro Express Job

Programming job file:

[ .!;-’-,nf.f;f;:-,qates.tgf;sou-thardfproj._ull_E.h.fls_d.;.ﬁ:IesiQneriflsort_-.i;f-éxpor-’t-fsor.t_d.j;:-b - |

FlashPro Express job project name:

0 sort_4

FlashPro Express job project location:

[ .!;-’-,of.f;f;:-,qates.tgf;sou-thardfproj;ull_éfls_el.ff.px -

(=

Figure 8 - New Job Project from FlashPro Express Job

FlashPro Express displays your Job Project and programmers, as shown in the figure below. The
Device/Programmer states are:

P |

e |IDLE: The devices/programmers are idle and not executing any programming action
e DISABLED: Devices that are not enabled for programming

e PASSED: The last programming operation passed

e FAILED: The last programming operation failed

[ FlasnPro Bpress Chtinelchanideacesichainldsvices. peo [ | = [l
Broject Edit View  Progrimmer Help

BafastiFimecan Programmars.
T (i ] AP [i] MES06 [i] MESOST
@Toa ™o St ™o Gt o <

1 BF e IME e DL DE
: @ e IDE e o HLE

i B ILE E LE HME
4 BF e e D oiE I
s @Y sun ILE IE IDUE BOLE
e BF sz e e meE oE

BT s IDE s RE mME
s @ s e e e BLE
s @PF = s e meE mE
w @E e e e e I
PROGRAM -

RUN IDLE
Log *x

prograsmes !

Frogcasmes '8

prograsmer

prograeser !

prograsmer 86

prograsmer ‘85746 ¢

Opened *Ci ki ranschainddevices /chainidevices, pro
Froject sawed. -

Figure 9 - FlashPro Express with Loaded Job Project (JTAG example)
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E FlashPro Express E)\sd1_spi_slave\sd1 spi_slave.pro - SPI Slave Programming Interface

Project Edit View Programmer Help

Refresh/Rescan Programmers

©  m2csisoTs  dEE
Programmer
< $00 51 2
j @V [saos DLE IDLE
PROGRAM A
Log & x
(Z) Messages &3 Errors 4. Warnings @ Info
=]

PPD file 'E:\sdl spi slave\sdl spi slave.ppd' has been loaded successfully.
DESIGN : sdl; CHECKSUM : 7EB7; PDB_VERSION : 1.0

creating folder: E:\sdl_spi_slave\projectData

Software Version: 12.500.0.14

PPD file '"E:\sdl_spi_slave\sdl_spi_slave.ppd' has been loaded successfully.

DESIGN : =sdl; CHECKSUM : TE87; PDBE_VERSICN : 1.0
Driver : 3.0.0 build 1
programmer '84093' : FlashProd

Created FlashPro Express Job Project.

Figure 10 - FlashPro Express with Loaded Job Project (SPI Slave example — SmartFusion2/IGLOO2 only)
See the Export Programming Job topic for information on how to generate a Programming Job file.

3. Click the Refresh/Rescan button if your programmer is not listed. Hover your mouse over the Info icon to
view device info. If a device is Disabled for programming the HighZ status appears in the GUI, as shown in
the figure above.

4. Setthe Programming Action in the dropdown menu to PROGRAM, as shown in the figure below.

|PROGRAM -]
DEVICE_INFO
EMC_DATA_AUTHEMTICATION
ERASE

|READ _IDCODE |
g VERIFY 18

Figure 11 - Programming Action Set to PROGRAM

5. Click RUN. Detailed individual programmer and device status information appears in the Programmer List.
Your programmer status (PASSED or FAILED) appears in the Programmer Status Bar, as shown in the

figure below.
e Hover over the Programmer Status Bar to display information on the programmers.

e Hover over the FAILED status to list all programmers that failed programming.
e Hover over the PASSED status to list all the programmers that programmed successfully.

14
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[ FlashPro Express CMij\FPexpress_Tutorial\FPexpress_projectiestitestpra
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Figure 12 - Chain Programming Complete
View the Log for Messages, Errors, Warnings and Info generated during programming
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Programmer Settings and Operations

Introduction

The FlashPro Express software enables you to connect multiple programmers to your computer. With each
programmer you select, you can connect the programmer, perform a self-test, customize, add, and remove and
analyze the JTAG chain, as shown in the figure below.

EE FlashPro Express Z:\QTFP_testing\pc_pro_FP\m2s050_896fbga_fab\m2s050_896fbga_fab.pro

Project Edt View Prognmme  Help
Refrash/Rescan Programmers
(i ] MZ5050T
Pr ey
facs = TDO Ol 3
1 | @E |wm e R —
2 s b i
Self Test
Scan and check chain
Remave
Enable,Disable
PROGRAN -
Log & x
(E]) Messages | €hEmors  f) Wamings i) Info
STAPL file °'Z:\QTFF_testing\pc_pro_FP\uZs050_896fbga_fab\projectDatalsdl,stp’ has heen losded successfully. -
DESIGN : sdl; CHECKSUM : 9EDF; ALG_VERSION : 2
Driver : 3.0.0 build 1
programmer '87272' : FlashProd
Opened *Z:/QTFP_testing/pc_pro_FP/m2s0S0_896Chgs_fab/a2s050_896fbga_fab.pro' -

Figure 13 - FlashPro Express Right-Click Menu

Programmer Settings

In the Libero SoC Design Flow window, expand Configure Hardware, double-click Configure Programmer, or
right-click Configure Programmer and choose Programmer Settings to view the Programmer Settings dialog.

For the JTAG interface, you can set specific voltage and force TCK frequency values for your programmer in this
dialog. For the SPI Slave interface, you can set specific voltage and force SCK frequency values for your
programmer. SPI Slave mode is supported by FlashPro5 for SmartFusion2 and IGLOQO?2 devices, and by
FlashPro6 for SmartFusion2, IGLOO2, and PolarFire devices. SPI Slave mode is not supported for RTG4
devices. JTAG is the default interface.
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E

[» | Programmer Settings

FlashPro6 FlashPros FlashPro4

L || Set Vpump

JTAG interface
TCK Mode: Free Running Clock

Force TCK Frequency

&3

FlashPro3 FlashPro Lite ] Flas E]

SPI Slave interface
SCK Mode: Free Running Clock

Force SCK Frequency

Set Defaults

Help | oK

Figure 14 - Programmer Settings

Cancel

The Programmer Settings dialog includes setting options for FlashPro6/5/4/3/3X.
Limitation of the TCK frequency for the selected programmer:
e FlashPro6: 1, 2, 3,4,5,6,7,8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20 MHz
e FlashPro5: 1, 2, 3, 4,5, 6,10, 15, 30 MHz
e FlashPro4:1, 2, 3,4,5, 6 MHz
e FlashPro3/3X: 1, 2,3, 4,6 MHz
TCK frequency limits by target device:
e Refer to target device data sheet

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file overrides the TCK
frequency setting selected by you in the Programmer Settings dialog box unless you also select the Force TCK
Frequency checkbox.

Limitation of the SCK frequency for the selected programmer: 1.00, 2.00, 2.50, 3.33, 4.00, 5.00, 6.67, 8.00, 10.00,
13.33, 20.00 MHz

FlashPro5/4/3/3X Programmer Settings

For FlashPro5/4/3/3X, you can choose the Set Vpump setting or the Force TCK Frequency. If you choose the
Force TCK Frequency, select the appropriate MHz frequency. For FlashPro4/3X settings, you can switch the TCK
mode between Free running clock and Discrete clocking. Discrete clocking should be used when there is a JTAG
non-compliant device in a chain with Microsemi devices. After you have made your selections(s), click OK.

Default Settings

e The Vpump option is checked to instruct the FlashPro5/4/3/3X programmer(s) to supply Vpump to the
device.
NOTE: VPUMP voltage will not be checked for the SmartFusion2/IGLOO2 and newer families of devices.
VPUMP does not need to be connected to the programmer for these devices.

e The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3/3X to use the TCK frequency
specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro5/4/3/3X default TCK mode setting is Free running clock.
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TCK Setting (Force TCK Frequency)

If Force TCK Frequency is checked (in the Programmer Setting), the selected TCK value is set for the
programmer and the Frequency statement in the PDB/STAPL file is ignored.

Default TCK frequency

When the IPD/STAPL file or Chain does not exist, the default TCK frequency is set to 4AMHz. When more than
one Microsemi flash device is targeted in the chain, the FlashPro Express software passes through all of the files
and searches for the "freq" keyword and the "MAX_FREQ" Note field. The FlashPro Express software uses the
lesser value of all the TCK frequency settings and the "MAX_FREQ" Note field values.

Ping Programmers

Right-click a programmer and choose Ping.
Note: You can click the Refresh/Rescan for Programmers button to quickly ping new programmers.

Performing a Self-Test

Right-click the programmer you want to self-test and choose Self Test.

Note: You must connect the programmer to the self-test board that comes with your programmer before
performing a self-test.

Note: Self-test is not supported with FlashPro5/4 programmers. These programmers are rigorously tested
at the factory during production.

Scanning and Checking a Chain

The scan chain operation scans and analyzes the JTAG chain connected to programmer(s) you have selected
and checks that chain scanned matches the chain configured in FlashPro Express.

To scan a chain:
Right-click the programmer you want to scan and choose Scan and check chain.

Enabling and Disabling Programmers

After loading a job project, you can enable/disable or remove a programmer and can also ping, self-test, run scan
and check chain on any of the connected programmers. These actions are available in the shortcut menu (right-
click) for each of the programmers listed in the programmer column.

Click the checkbox next to a programmer in the Programmer column to enable or disable it. The programmer is
enabled when there is a tick mark in the checkbox and disabled when the checkbox is empty.

Renaming a Programmer

Enter the new programmer name in the Programmer window to rename the programmer. By default, the
programmer name is the same as the programmer ID.

Removing a Programmer

Right-click the programmer and choose Remove.

Selecting and Running an Action

FlashPro Express supports the following programming actions:
e DEVICE_INFO
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e ENC_DATA_AUTHENTICATION
This action is only visible if every device in the chain contains encrypted bitstream files. Selecting this action
causes each bitstream file to be checked for authentication.

e ERASE

¢ PROGRAM

e READ_IDCODE
e VERIFY

To select a programming action:

Select an action from the Programming Action dropdown menu in FlashPro Express, as shown in the figure
below.

|PROGRAM. - |
| DEVICE_INFO
| ENC_DATA_AUTHEMTICATION
|ERASE
PROGRAM
|READ_IDCODE
’g VERIFY A

Figure 15 - FlashPro Express Programming Actions

To run the selected programming action:
Click on the RUN button below the Programming Action drop-down menu.
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Chain Programming

Chain Order

Chain Programming enables you to program several devices at one time. The order of devices in the chain
imported from Job Project must match the physical chain to be programmed.

The TDO for the first device connects to the programmer, and the last device's TDI connects to the programmer.
The devices in the chain go in order from a device's TDI into the next device's TDO, as shown in the figure below.

(22 Flashir Eepress Chkirn\chainddevicesichainddevices.pro = [ E e

Project  Edit  View  Programmer  Help

Refreshjfiescan Pragrammers

[ ] APIE0 [ ] MES060T [ ] MES050T

Frogrammer

0 anm IDLE HLE IELE ILE
: @F s DLE WLE LE LE
3 OF ene LE HAE IOLE IOLE
4+ @EF s IDLE HLE ILE ILE
5 @ swm LE e ELE e
. @F sun IE HLE IOLE DLE
7 @ e DLE OLE IOLE ILE
s @F owes IE ELE LE LE
s @ s DLE L OLE TLE
w @F s IME ILE ILE ILE Ul
[PRoGR -
7 RUN IDLE
L] 5 x

[[ElFias | @ Erars 4, Wamings @ Irfo
peogreaner '87L4D' : FlashProd
prograaner '83998' : FlashProd
prograamer 'G66EL' @ FlashProd
programmer '
prograamer '
Prograamer '95!
prograamer '34093' :
progreaner '87L.
prograamer '86ZL5' @ FlashProd

prograwmer '96745' : FlashProd

Operied ‘C: /kican/chainidevices /chainddevices.pea’
Project saved.

FlashPro4

FlashProd

Figure 16 - Chain Order

Multiple Device Chain Programming

The FlashPro Express software enables direct chain programming without generating a chain STAPL file. Each
device will be programmed in sequential order starting from device 1 to device N. See example below. For more
information about chain order, see the Chain Order help topic.

TDI > Device N > Device N-1 >... > Device 2 > Device 1 > TDO

Device Programming Compatibility
PolarFire, SmartFusion2, IGLOO2, and RTG4 devices can be programmed in the same chain.
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Programmer Support
FlashPro5/4/3/3X supports PolarFire, SmartFusion2, IGLOO2, and RTG4 devices. The Vpump on
FlashPro5/4/3/3X is designed to support the programming of only one device. Please make sure that Vpump, Vcc
and Vjtag are provided on board for chain programming. Connect the Vpump to the header as the Flashpro
Express software will attempt to check for all external supplies, including Vpump, to ensure successful
programming. There is no limitation to the chain length; however, ensure that the JTAG signal integrity and the
timing are preserved.
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TCL Commands - FlashPro Express

About TCL Commands - FlashPro Express Tcl Command
Reference

Note: For details about all Tcl commands supported by FlashPro Express, see the following documents:
Note: Tcl Command Reference Guide (SmartFusion2, IGLOO2, RTG4)
Note: Tcl Command Reference Guide (PolarFire)

A Tcl (Tool Command Language) file contains scripts for simple or complex tasks. You can run scripts from the
Windows command line or store and run a series of Tcl commands in a *.tcl batch file.

Note: Tcl commands are case sensitive. However, their arguments are not.

Running Tcl Scripts from within FlashPro Express

Instead of running scripts from the command line, you can use FlashPro Express's Execute Script dialog box to
run a script.

To execute a Tcl script file within FlashPro Express:
1. From the File menu, choose Execute Script to display the Run Script dialog box.

b
[Z4 Run Script A=)

Script File: | e

Arguments:

i) o

Figure 17 - Run Script Dialog Box

2. Click the Browse button to display the Open dialog box, in which you can navigate to the folder containing
the script file to open. When you click Open, FlashPro Express enters the full path and script filename into
the Run Script dialog box for you.

3. Inthe Arguments box, enter the arguments to pass to your Tcl script. Separate each argument by a space
character. For information about accessing arguments passed to a Tcl script, see Running Tcl Scripts From
the Command Line.

4, Click Run.

Running Tcl Scripts from the Command Line

You can run Tcl scripts from your Windows or Linux command line.
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To execute a Tcl script file in the FlashPro Express software from a shell command line:
1. Atthe prompt, type the path to the Microsemi software followed by the word "SCRIPT" and a colon, and then
the name of the script file as follows:
<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename>
The example below executes in batch mode the script foo.tcl:
<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl
The example below executes in batch mode the script foo.tcl and exports the log in the file foo.txt:
<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl logfile:foo.txt
The example below executes in batch mode the script foo.tcl, creates a console where the log is
displayed briefly, and exports the log in the file foo.txt:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tclconsole _mode:brief
logfile:foo.txt

If you leave console_mode unspecified or set it to 'hide’ FlashPro Express executes without a console
window. If you want to leave the console window open you can run the script with the console_mode
parameter set to 'show’, as in the following example:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl console_mode:show
logfile:foo.txt

2. If you want to pass arguments to the Tcl script from the command line, then use the "SCRIPT_ARGS"
variable as follows:

<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename>SCRIPT_ARGS:"paraml
param2 param3"

Arguments passed to a Tcl script can be accessed through the Tcl variables argc and argv. The example
below demonstrates how a Tcl script accesses these arguments:

puts "Script name: $argv0"
puts "Number of arguments: $argc"
set i 0
foreach arg $argv {
puts "Arg $i : $arg"
incr i
}
Note: Script names can contain spaces if the script name is protected with double quotes:
FPExpress script:"FPExpress tcl/foo 1.tcl"

Exporting Tcl Scripts from within FlashPro Express

To export a set of Tcl commands from the FlashPro Express history:

1. From the File menu, choose Export Script File.
2. Enter the filename and click Save. The Export Script Options dialog appears (as shown in the figure below).
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[E3 Bxport Script L9 o

Script file: pxported.td [Z]
Files name formatting

FlashPro Express User Guide

| Relative file names (relative to the script file location)

) Qualified file names (full path; induding directory name)

ok ][ comcel ]

Rt =4
Figure 18 - Script Export Options Dialog Box

Check the Include commands from current project only to export commands of the current project
only. You can specify the filename formatting by selecting Relative filenames (relative to the current
directory) or Qualified filenames (absolute path, including the directory name).

4. Click OK.
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Troubleshooting

Exit Codes (PolarFire)

Error Exit Message Exit Possible Cause Possible Solution
Code Code
Passed (no error) 0 - -
0x8002 Failed to disable 5 Unstable voltage level Monitor related power supplies that cause the
programming mode issue during programming; check for transients
Signal integrity issues on outside of Microsemi specifications. See your
Failed to set JTAG pins device datasheet for more information on
programming mode transient specifications.
Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8032 Device is busy 5 Unstable VDDIx voltage Monitor related power supplies that cause the
level issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.
0x8003 Failed to enter 5 Unstable voltage level Monitor related power supplies that cause the
programming mode issue during programming; check for transients
Signal integrity issues on outside of Microsemi specifications. See your
JTAG pins device datasheet for more information on
transient specifications.
DEVRST_N is tied to LOW
Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
Tie DEVRST_N to HIGH prior to programming
the device.
0x8004 Failed to verify 6 Incorrect programming file Choose the correct programming file and select
IDCODE the correct device in the chain.
Incorrect device in chain
Measure JTAG pins and noise for reflection. If
Signal integrity issues on TRST is left floating then add pull-up to pin.
JTAG pins
Reduce the length of Ground connection.
0x8005 Failed to verify FPGA | 11 Device is programmed with | Verify the device is programmed with the
0x8006 Array a different design or the correct data/design.
0x8007 component is blank.
0x8008 Failed to verify Fabric Monitor related power supplies that cause the
Configuration Unstable voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Failed to verify Signal integrity issues on device datasheet for more information on
Security JTAG pins. transient specifications.
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
Monitor JTAG supply pins during programming;
Failed to verify SNVM measure JTAG signals for noise or reflection.
0x8013 External digest check | -18 External Digest check via Need to use a bitstream file which has a valid
via JTAG/SPI Slave is JTAG/SPI Slave is disabled. | FlashLock/UPK1 to enable external digest
disabled. check via JTAG/SPI Slave.
0x8015 FPGA Fabric digest -20 FPGA Fabric is either If the Fabric is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_FABRIC" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_FABRI
C' to remove this
digest check.
0x8016 sNVM digest -20 SNVM is either erased or the | If the SNVM is erased, deselect procedure
verification: FAIL data has been corrupted or | "DO_ENABLE_SNVM" from action
tampered with "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_SNVM'
to remove this digest
check.
0x8018 User security -20 Security segment is either If the security is erased, deselect procedure
policices segment erased or the data has been | "DO_ENABLE_SECURITY" from action
digest verification: corrupted or tampered with | "VERIFY_DIGEST"
FAIL
Deselect procedure
'DO_ENABLE_SECU
RITY' to remove this
digest check.
0x8019 UPK1 segment digest | -20 UPK1 segment is either If the UPK1 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_SECURITY" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_SECU
RITY' to remove this
digest check.
0x801A UPK2 segment digest | -20 UPK2 segment is either If the UPK2 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_UKS2" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_UKS2'
to remove this digest
check.
0x801B Factory row and -20 Factory row and factory key
factory key segment segment have been erased
digest verification: through zeroization or the
FAIL data has been corrupted or
tampered with
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
0x801C Fabric configuration -20 Fabric configuration If the Fabric configuration is erased, deselect
segment digest segment is either erased or | procedure "DO_ENABLE_FABRIC" from action
verification: FAIL has been corrupted or "VERIFY_DIGEST"
tampered with
Deselect procedure
'DO_ENABLE_FABRI
C' to remove this
digest check.
0x8052 UEK1 segment digest | -20 UEK1 segment is either If the UEK1 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_UEK1" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_UEKY'
to remove this digest
check.
0x8053 UEK2 segment digest | -20 UEK2 segment is either If the UEK?2 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_UEK2" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_UEK2'
to remove this digest
check.
0x8054 DPK segment digest | -20 DPK segment is either If the DPK is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_DPK" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_DPK'
to remove this digest
check.
0x8057 SMK segment digest | -20 SMK segment is either If the SMK is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_SMK" from action
corrupted or tampered with | "VERIFY_DIGEST"
0x8058 User Public Key -20 User Public Key segment is | If the User Public Key is erased, deselect
segment digest either erased or the data procedure
verification: FAIL has been corrupted or "DO_ENABLE_USER_PUBLIC_KEY" from
tampered with action "VERIFY_DIGEST"
0x801D Device security -21 The device is protected with | Run DEVICE_INFO to view security features
prevented operation user pass key 1 and the that are protected.
bitstream file does not
contain user pass key 1. Provide a bitstream file with a user pass key 1
that matches the user pass key 1 programmed
User pass key 1 in the into the device.
bitstream file does not
match the device.
0x801F Programming Error. -22 Bitstream file has been Regenerate bitstream file
corrupted or was incorrectly
generated. Monitor related power supplies that cause the
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
Bitstream or data is issue during programming; check for transients
corrupted or noisy Unstable voltage level. outside of Microsemi specifications. See your
device datasheet for more information on
Signal integrity issues on transient specifications.
JTAG pins. Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8021 Programming Error. -23 File contains an encrypted Provide a programming file with an encryption
key that does not match the | key that matches that on the device
Invalid/Corrupted device
encryption key First program security with master programming
File contains user file, then program with user encryption 1/2 field
encryption key, but device update programming files
has not been programmed
with the user encryption key
0x8023 Programming Error. -24 Design version is not higher | Generate a programming file with a design
than the back-level version higher than the back level version
Back level not programmed device
satisfied
0x8001 Failure to read DSN -24 Device is in System TRSTB should be driven High or disable
Controller Suspend Mode "System Controller Suspend Mode".
Check board connections
0x8027 Programming Error. -26 Device does not support the | Generate a programming file with the correct
capabilities specified in capabilities for the target device
Insufficient device programming file
capabilities
0x8029 Programming Error. -27 Incorrect programming file Choose the correct programming file and select
the correct device in chain
Incorrect DEVICEID Incorrect device in chain
Measure JTAG pins and noise or reflection. If
Signal integrity issues on TRST is left floating, then add pull-up to pin
JTAG pins
Reduce the length of ground connection
0x802B Programming Error. -28 Programming file version is | Generate programming file with latest version of
out of date Libero SoC
Programming file is
out of date, please
regenerate.
0x8030 Programming Error -31 FAB_RESET N is tied to FAB_RESET_N should be tied to HIGH
ground
Invalid or inaccessible
Device Certificate
0x8032 Instruction timed out | -32 Unstable voltage level Monitor related power supplies that cause the
0x8034 issue during programming; check for transients
0x8036 Signal integrity issues on outside of Microsemi specifications. See your
0x8038 JTAG pins device datasheet for more information on
transient specifications.
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8010 Failed to unlock user | -35 Pass key in file does not Provide a programming file with a pass key that
pass key 1 match device matches pass key programmed into the device.
0x8011 Failed to unlock user | -35 Pass key in file does not Provide a programming file with a pass key that
pass key 2 match device matches pass key programmed into the device.
0x804F Bitstream -38 Unstable voltage level Monitor related power supplies that cause the
programming action is issue during programming; check for transients
disabled Bitstream programming outside of Microsemi specifications. See your
action has been disabled in | device datasheet for more information on
Security Policy Manager transient specifications.
Need to use a bitsream file which has a valid
FlashLock/UPK1 to enable the bitstream
programming action.
0x805B Error, security must -42 Security only bitstream Use this bitstream on a blank device or
be either programmed programming on a generate a new bitstream that contains the
on a blank device or programmed device FPGA Fabric design along with the security
with the FPGA Fabric
design

Exit Codes (RTGA4)

Error Code Exit Message Possible Cause Possible Solution
Passed (no - -
error)
0x8001 Failure to read Device is in System Controller | TRSTB should be driven High on
DSN Suspend Mode device power up.
Check board connections Disable System Controller
Suspend Mode in "Programming
Bitstream Settings' tool within
Libero and reprogram the device.
0x8002 Device is busy [ Unstable VDDIx voltage level Monitor related power supplies
that cause the issue during
programming; check for transients
outside of Microsemi
specifications. See your device
datasheet for more information on
transient specifications.
0x8003 Failed to enter | Unstable voltage level Monitor related power supplies
programming that cause the issue during
mode Signal integrity issues on programming; check for transients
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Error Code Exit Message Possible Cause Possible Solution
JTAG pins outside of Microsemi
specifications. See your device
DEVRST N is tied to LOW datasheet for more information on
transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG
signals for noise or reflection.
Tie DEVRST_N to HIGH prior to
programming the device
0x8004 Failed to verify | Incorrect programming file Choose the correct programming
IDCODE file and select the correct device in
Incorrect device in chain the chain.
Signal integrity issues on Measure JTAG pins and noise for
JTAG pins reflection. If TRST is left floating
then add pull-up to pin.
Reduce the length of Ground
connection.
0x8005 Failed to verify | Programming file is for Generate a programming file for
IDCODE RT4G150_ES and device is RT4G150 device
RT4Gl5_0_|_ES RT4G150 Choose the correct programming
STAPL file IEI Incorrect programming file file and select the correct device in
not compatible 1o rrect device in chain the chain.
with RT4G150 . d noise f
production Signal integrity issues on Measqre JTAG pins and noise for
devices. You JTAG pins reflection. If TRST |slleft floating
must use a then add pull-up to pin.
STAPL file for Reduce the length of Ground
RT4G150 connection.
device.
0x8006 Failed to verify | Programming file is for Generate a programming file for
IDCODE RT4G150 and device is RT4G150_ES device
RT4Gl5_0 . RTAG150_ES Choose the correct programming
STtAPL met'ltfl Incorrect programming file file and select the correct device in
not compatidie | | correct device in chain the chain.
with . .
RTAG150 ES | Signal integrity issues on Measqre JTAG pins and noise for
. -~ ; reflection. If TRST is left floating
devices. You JTAG pins .
then add pull-up to pin.
must use a
STAPL file for Reduce the length of Ground
RT4G150_ES connection.
device.
0x8007 Failed to verify | Device is programmed with a | Verify the device is programmed
FPGA Array different design or the with the correct data/design.
component is blank. Monitor related power supplies
Unstable voltage level. that cause the issue during
Signal integrity issues on proglramming; checK for transients
JTAG pins. outside of Microsemi
specifications. See your device
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Error Code Exit Message Possible Cause Possible Solution
datasheet for more information on
transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG
signals for noise or reflection.
0x8008 Device is blank | Attempting to verify digest of a | Program the device prior to
blank device running action "VERIFY_DIGEST"
0x8009 FPGA array Digest check has been Drive TRSTB high during device
digest check is | disabled by "Programming power up.
disabled Bitstream Settings” tool within | naple digest check in
Libero "Programming Bitstream Settings"
tool within Libero and reprogram
the device.
0x800A Failed to verify | Unstable voltage level Try running VERIFY_DIGEST
digest: Signal integrity issues on action again.
Instruction JTAG pins Monitor related power supplies
timed out that cause the issue during
programming; check for transients
outside of Microsemi
specifications. See your device
datasheet for more information on
transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG
signals for noise or reflection.
0x800B FPGA Fabric Programming bitstream Use the same programming file
digest components do not match that was used to program the
verification: components programmed device.
FAIL FPGA Fabric is either erased
or the data has been corrupted
or tampered with
0x800C Factory row Programming bitstream Use the same programming file
segment digest | components do not match that was used to program the
verification: components programmed device.
FAIL Factory row segment data has
been corrupted or tampered
with
0x800D Bitstream Error. | Bitstream file has been Regenerate bitstream file
Bitstream or corrupted Monitor related power supplies
data is Bitstream was incorrectly that cause the issue during
corrupted or generated programming; check for transients
noisy. i ; i
e Unstable voltage level outside of Microsemi .
Signal intearity i specifications. See your device
J_:_?Ang integrity 1Ssues on datasheet for more information on
pins transient specifications.
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Error Code Exit Message Possible Cause Possible Solution
Monitor JTAG supply pins during
programming; measure JTAG
signals for noise or reflection.

0x800E Failed to query | Unstable voltage level Try running DEVICE_INFO action
programming | signal integrity issues on again.
bitstream JTAG pins Monitor related power supplies
settings: that cause the issue during
Instruction programming; check for transients
timed out outside of Microsemi
specifications. See your device
datasheet for more information on
transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG
signals for noise or reflection.
0x800F Bitstream Error. | Incorrect programming file Choose the correct programming
Incorrect Incorrect device in chain file and select the correct device in
DEVICEID . . - the chain.
Signal integrity issues on ] ]
JTAG pins Measgre JTAG pins and noise for
reflection. If TRST is left floating
then add pull-up to pin.
Reduce the length of Ground
connection.
0x8010 Operation has | Operation has been disabled Drive TRSTB high during device
been disabled | by "Programming Bitstream power up
by _ Settings” tool within Libero Enable the disabled operation in
programming | yser disabled Fabric the "Programming Bitstream
bitstream Erase/Write/Verify and Settings" tool with Libero and
settings attempted to reprogram the device
Erase/Program/Verify the
device
0x8011 Failed to check | Unstable voltage level Monitor related power supplies

bitstream:
Instruction
timed out

Signal integrity issues on
JTAG pins

that cause the issue during
programming; check for transients
outside of Microsemi
specifications. See your device
datasheet for more information on
transient specifications.

Monitor JTAG supply pins during

programming; measure JTAG
signals for noise or reflection.

0x8012, 0x8013

Failed to erase
device:
Instruction
timed out

Unstable voltage level Signal
integrity issues on JTAG pins

Monitor related power supplies
that cause the issue during
programming; check for transients
outside of Microsemi
specifications. See your device
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Error Code Exit Message Possible Cause Possible Solution

datasheet for more information on
transient specifications.
Monitor JTAG supply pins during

programming; measure JTAG
signals for noise or reflection.

0x8014 Failed to Unstable voltage level Monitor related power supplies
program Signal integrity issues on that cause the issue during
device: JTAG pins programming; check for transients
Instruction outside of Microsemi
timed out specifications. See your device

datasheet for more information on
transient specifications.
Monitor JTAG supply pins during

programming; measure JTAG
signals for noise or reflection.

0x8015 Error, device is | DEVRST_N may have been Need to ensure that DEVRST_N is
not ready. driven LOW during driven HIGH during programming.
programming The reliability of the device in

space cannot be guaranteed if this
has occurred. It is the user's
responsibility to ensure that
DEVRST_N is driven HIGH during
programming.

Exit Codes (SmartFusion2 and IGLOQO2)

Error Exit Exit Message Possible Cause Possible Solution
Code Code
0 Passed (no error) - -
0x8002 5 Failure to configure Unstable voltage level Monitor related power supplies that cause
device programming at the issue during programming; check for
1.2/1.0 VCC voltage Signal integrity issues on transients outside of Microsemi
JTAG pins specifications. See your device datasheet
for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8032 5 Device is busy Unstable VDDIx voltage level | Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x8003 5 Failed to enter Unstable voltage level Monitor related power supplies that cause
programming mode the issue during programming; check for
Signal integrity issues on transients outside of Microsemi
JTAG pins specifications. See your device datasheet
for more information on transient
DEVRST N is tied to LOW specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
Tie DEVRST_N to HIGH prior to
programming the device.
0x8004 6 Failed to verify IDCODE | Incorrect programming file Choose the correct programming file and
select the correct device in the chain.
Incorrect device in chain
Measure JTAG pins and noise for
Signal integrity issues on reflection. If TRST is left floating then add
JTAG pins pull-up to pin.
Reduce the length of Ground connection.
0x8005 |10 Failed to program eNVM | Unstable voltage level. Monitor related power supplies that cause
0x8006 the issue during programming; check for
8x804A Signal integrity issues on transients outside of Microsemi
JTAG pins. specifications. See your device datasheet
for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8027 10 Authentication Error Libero device selection does | Generate a programming file with the
0x8028 not match the target device. correct device selection for the target
Bitstream and device device.
mismatch
0x8007 11 Failed to verify FPGA Device is programmed with a | Verify the device is programmed with the
0x804C Array different design or the correct data/design.
component is blank.
Failed to verify Fabric Monitor related power supplies that cause
Configuration Unstable voltage level. the issue during programming; check for
transients outside of Microsemi
Failed to verify Security | Signal integrity issues on specifications. See your device datasheet
JTAG pins. for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x8008 11 Failed to verify eNVM Device is programmed with a | Verify the device is programmed with the
0x8009 different design. correct data/design.
0x8049
Unstable voltage level. Monitor related power supplies that cause
the issue during programming; check for
Signal integrity issues on transients outside of Microsemi
JTAG pins. specifications. See your device datasheet
for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8013 -18 Digest request from Digest request from SPI/JTAG | Provide a programming file with a pass
SPI/JTAG is protected by | is protected by user pass key | key that matches pass key programmed
User Pass Key 1 1. Lock bit has been into the device.
configured in the Debug Policy
within SPM (Security Policy
Manager)
0x8014 -19 Failed to verify digest >Unstable voltage level Monitor related power supplies that cause
the issue during programming; check for
Signal integrity issues on transients outside of Microsemi
JTAG pins specifications. See your device datasheet
for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8015 -20 FPGA Fabric digest Programming bitstream Use the same programming file that was
verification: FAIL components do not match used to program the device.
components programmed
FPGA Fabric is either erased
or the data has been
corrupted or tampered with
0x8016 -20 eNVM_0 digest Programming bitstream Use the same programming file that was
verification: FAIL components do not match used to program the device.
components programmed
eNVM_0 data has been
corrupted or tampered with
0x8017 -20 eNVM_1 digest Programming bitstream Use the same programming file that was
verification: FAIL components do not match used to program the device.
components programmed
eNVM_1 data has been
corrupted or tampered with
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x8018 -20 User security policies Programming bitstream Use the same programming file that was
segment digest components do not match used to program the device.
verification: FAIL components programmed
User security policy segment
data has been corrupted or
tampered with
0x8019 -20 User key set 1 segment | Programming bitstream Use the same programming file that was
digest verification: FAIL | components do not match used to program the device.
components programmed
User key set 1 segment data
has been corrupted or
tampered with
0x801A -20 User key set 2 segment | Programming bitstream Use the same programming file that was
digest verification: FAIL | components do not match used to program the device.
components programmed
User key set 2 segment data
has been corrupted or
tampered with
0x801B -20 Factory row and factory | Programming bitstream Use the same programming file that was
key segment digest components do not match used to program the device.
verification: FAIL components programmed
Factory row and factory key
segment data has been
corrupted or tampered with
0x801C -20 Fabric configuration Programming bitstream Use the same programming file that was
segment digest components do not match used to program the device.
verification: FAIL components programmed.
Fabric configuration segment
data has been corrupted or
tampered with
0x801D |-21 Device security The device is protected with
O0x801E prevented operation user pass key 1 and the
0x804B bitstream file does not contain | Run DEVICE_INFO to view security
user pass key 1. features that are protected.
User pass key 1 in the Provide a bitstream file with a user pass
bitstream file does not match | key 1 that matches the user pass key 1
the device. programmed into the device.
0x801F -22 Authentication Error eNVM has been locked by a Release the lock on the eNVM after your
0x8020 master in your design master has completed its access
0x8040 Bitstream or data is operations. Write 0x00 to "REQACCESS"
corrupted or noisy Running VERIFY action on a | register in eNVM Control Registers
blank device. (address 0x600801FC) to release the
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
access.
Bitstream file has been
corrupted Program the device prior to running
VERIFY action
Bitstream was incorrectly
generated Regenerate bitstream file.
0x8021 -23 Authentication Error File contains an encrypted key | Provide a programming file with an
0x8022 that does not match the encryption key that matches that on the
Invalid/Corrupted device device.
encryption key
Attempting to erase a device | Run DEVICE_INFO action to verify that
with no security using master | the device has no security. If the device
security file does not have secuirty, you cannot erase
it.
File contains user encryption
key, but device has not been | First program security with master
programmed with the user programming file, then program with user
encryption key encryption 1/2 field update programming
files.
Device has user encryption
key 1/2 enforced and you are | You must first ERASE security with the
attempting to reprogram master security file, then you can
security settings reprogram new security settings.
0x8041 -23 Authentication Error File contains an encrypted key | Provide a programming file with an
that does not match the encryption key that matches that on the
Invalid/Corrupted device device.
encryption key
File contains user encryption | Run DEVICE_INFO action to verify that
key, but device has not been | the device has no security. If the device
programmed with the user does not have secuirty, you cannot erase
encryption key it.
Attempting to erase a device | First program security with master
with no security using master | programming file, then program with user
security file encryption 1/2 field update programming
files.
Device has user encryption
key 1/2 enforced and you are | You must first ERASE security with the
attempting to reprogram master security file, then you can
security settings reprogram new security settings.
0x8023 -24 Authentication Error Design version is not higher Generate a programming file with a design
0x8024 than the back-level version higher than the back level version.
0x8042 Back level not satisfied programmed device
0x8001 -24 Failure to read DSN Device is in System Controller | TRSTB should be driven High or disable
Suspend Mode "System Controller Suspend Mode".
Check board connections
0x8025 -25 Authentication Error DSN specified in programming | Use the correct programming file with a
0x8026 file does not match the device | DSN that matches the DSN of the target
0x8043 DSN binding mismatch being programmed device being programmed.
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
-26 Authentication Error Device does not support the Generate a programming file with the
0x8044 capabilities specified in correct capabilities for the target device.
Insufficient device programming file
capabilities
0x8027 -26 Authentication Error Libero device selection does | Generate a programming file with the
0x8028 not match the target device correct device selection for the target
Bitstream and device device.
mismatch
0x8029 -27 Authentication Error Incorrect programming file Choose the correct programming file and
0x802A select the correct device in chain.
0x8045 Incorrect DEVICEID Incorrect device in chain

Measure JTAG pins and noise or

Signal integrity issues on reflection. If TRST is left floating, then add
JTAG pins pull-up to pin.

Reduce the length of ground connection.
0x802B -28 Authentication Error Programming file version is Generate programming file with latest
0x802C out of date version of Libero SoC.

Programming file is out
of date, please
regenerate
0x8046 -28 >Authentication Error Old programming file Generate programming file with latest
version of Libero SoC.
Unsupported bitstream
protocol version
0x802F -30 JTAG interface is Invalid or no UPK1 is provided | User needs to provide correct UPK1 to
protected by UPK1 unlock device.
0x8030 -31 Authentication Error M2S090 Rev. A or M2S150 User can program a valid application
0x8031 Rev. A: code. This can be done with SoftConsole.
0x8048 Invalid or inaccessible
Device Certificate Either certificate is corrupted FAB_RESET_N should be tied to HIGH.
or the user hasn't provided the
application code in the eNVM
or provided invalid application
code
FAB_RESET_N is tied to
ground
0x8032 -32 Instruction timed out Unstable voltage level Monitor related power supplies that cause
0x8033 the issue during programming; check for
0x8034 Signal integrity issues on transients outside of Microsemi
0x8035 JTAG pins specifications. See your device datasheet
0x8036 for more information on transient
0x8037 specifications.
0x8038
0x8039 Monitor JTAG supply pins during
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
programming; measure JTAG signals for
noise or reflection.
0x8010 -35 Failed to unlock User Pass key in file does not Provide a programming file with a pass
Pass Key 1 match device. key that matches pass key programmed
into the device.
Plaintext pass key match is
disabled. This occurs if HSM Match pass key using HSM.
was used to program the
device.
0x8011 -35 Failed to unlock User Pass key in file does not Provide a programming file with a pass
Pass Key 2 match device. key that matches pass key programmed
into the device.
Plaintext pass key match is
disabled. This occurs if HSM Match pass key using HSM.
was used to program the
device.
0x8012 -35 Failed to unlock debug Pass key in file does not Provide a programming file with a pass
pass key match device. key that matches pass key programmed
into the device.
Plaintext pass key match is
disabled. This occurs if HSM Match pass key using HSM.
was used to program the
device.
0x804D -36 <HSM related error HSM communication error. Check if HSM the communication path to
message based on HSM call returns error. HSM is up. Make sure project is loaded
scenario> properly and that HSM tickets have not
been cleaned.
0x804E -37 Device already has HSM flow does not support Erase security and try programming the
Security programmed. reprogramming device directly | device.
Please erase the device | if Security has already been
using master file before | programmed.
reprogramming Security
Settings.
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SmartDebug

Microsemi’s SmartDebug tool complements design simulation by allowing verification and troubleshooting at the
hardware level.

For detailed information about SmartDebug for SmartFusion2, IGLOO2, and RTG4, refer to the SmartDebug User
Guide (SmartFusion2, IGLOO2, RTG4).

For detailed information about SmartDebug for PolarFire, refer to the SmartDebug User Guide (PolarFire).
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Electrical Parameters

DC Characteristics for FlashPro6

Table 2 - DC Characteristic for FlashPro6

Parameter Test VITAG Min Typ Max Unit
Condition Voltage
Range
V4 High- 1.20V - 1.95V | VJTAG_VSPI \%
level input x 0.65
voltage
1.95V-2.70V | 1.6 \%
2.70V -3.60V | 2 \%
VL Low- 1.20V - 1.95V VJITAG_VSPIx0.35 \%
level input
voltage 1.95V - 2.70V 0.7 \%
2.70V - 3.60V 0.8 \%
Vo lon=—100pA | 1.2Vt03.6V | VITAG_VSPI \%
-0.2
lon=-3mA 1.2v \
lon=-6MA 1.4V 1.05 \%
lon=-8mA 1.65V 1.2 0.95 \%
lon=-9mA 2.3V 1.75 \%
lon=-12mA 3V 2.3 \%
VoL lon=-100pA | 1.2Vto3.6V \%
lon=-3mA 1.2v 0.25 \%
lon = -6mA 1.4V \%
lon=-8mA 1.65V \%
lon=-9mA 2.3V \%
lon=-12mA 3V \%
lon High- 1.1Vtol2V -3 mA
level output
current 14Vtol6V -6 mA
1.65V to -8 mA
1.95vV
23Vto27V -9 mA
3Vto3.6V -12 mA
11Vtol2V 3 mA
14Vtol6V 6 mA
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loL Low-level 1.65V to 8 mA
output 1.95v
current
23Vto2.7V 9 mA
3Vto36V 12 mA

DC Characteristics for FlashPro5/4/3/3X

Note: The target board must provide the VCC, VCCI, VPUMP, and VJTAG during programming.

Note: The VJTAG signal is driven from the target/DUT board. The VJTAG pin is sensed by the FP4 to

configure the internal input and output buffers to the same IO Voltage levels. The VITAG pin is only

an input pin to the programmer.
Table 3 - DC Characteristic for FlashPro5/4/3/3X

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.35*VJTAG \%
Input high voltage, TDO VIH 0.65*VJTAG 3.6 \%
Input current, TDO 1L, IH -20 +20 mA
Input capacitance, TDO 40 pF
Output voltage, VPUMP, operating VPP +3.0 +3.6 \%
Output current, VPUMP IPP 250 mA
VITAG = 1.5V
Output low voltage, TCK, TMS, TDI, 100pA load VOL 0.0 0.2 \Y
Output low voltage, TCK, TMS, TDI, 4mA load VOL 0.0 0.30*VJTAG \Y
Output high voltage, TCK, TMS, TDI, 100pA load |V VJITAG-0.2 VITAG \%
Output high voltage, TCK, TMS, TDI, 4mA load VOH 0.70*VJTAG VITAG \Y
Output current, TCK, TMS, TDI IOL, IOH | -4 +4 mA
VITAG = 1.8V
Output low voltage, TCK, TMS, TDI, 100uA load | VOL 0.0 0.2 \%
Output low voltage, TCK, TMS, TDI, 6mA load VOL 0.0 0.3 \%
Output high voltage, TCK, TMS, TDI, 100pA load | VOH VJITAG-0.2 VITAG \%
Output high voltage, TCK, TMS, TDI, 6mA load VOH 1.25 VITAG \%
Output current, TCK, TMS, TDI 0L, IOH | -6 +6 mA
VITAG = 2.5V
Output low voltage, TCK, TMS, TDI, 100uA load | VOL 0.0 0.2 \%
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Description Symbol Min Max Unit

Output low voltage, TCK, TMS, TDI, 8mA load VOL 0.0 0.6 \%
Output high voltage, TCK, TMS, TDI, 100pA load | VOH VJITAG-0.2 VITAG \Y
Output high voltage, TCK, TMS, TDI, 8mA load VOH 1.8 VITAG \%
Output current, TCK, TMS, TDI I0L, IOH | -8 +8 mA
VITAG = 3.3V

Output low voltage, TCK, TMS, TDI, 100pA load VOL 0.0 0.2 \Y
Output low voltage, TCK, TMS, TDI, 8mA load VOL 0.0 0.4 \%
Output high voltage, TCK, TMS, TDI, 100pA load | VOH VJITAG-0.2 VITAG \%
Output high voltage, TCK, TMS, TDI, 8mA load VOH 2.4 VITAG \%
Output current, TCK, TMS, TDI I0L, IOH | -8 +8 mA
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Electrical Specifications

FlashPro6

The FlashPro6 is a JTAG-based programmer for flash based Microsemi devices.

The FlashPro6 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro6 unit is a 2x5, RA male Header connector, which is manufactured by 3M and has a manufacturer’s
part number of N2510-5002-RB. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-

angle header, 3M P/N N2510-5002-RB (DigiKey P/N MHE10K-ND) for FlashPro6 and use the 10 pin straight
header,

The signals on the pins of the FlashPro6 10-pin connector are shown in the figure below.

«— TCK/SCK |1 2 |GND «—>

— TDO/MISO |3 4 | NC

<4— TMS/SS 5 6 | VITAG/VSPI <4—
NC[7 8 |TRSTB i

<«— TDI/MOSI [9 10/ GND a3

Figure 19 - FlashPro6 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer itself.
Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 4 - FlashPro6 Signal Description

Signal Description
GND Signal reference
TCK/SCK JTAG clock; SPI clock
TDI/SDI JTAG data input to device; SPI MOSI
TDO/SDO JTAG data output from device; SPI MISO
TMS/SS# JTAG mode select; SPI Chip Select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

FlashPro5

The FlashPro5 is a JTAG and a SPI based programmer for flash based Microsemi devices.

The FlashPro5 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro5 unitis a 2x5, RA male Header connector, which is manufactured by AMP and has a manufacturer's
part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-angle
header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10 pin straight header, AMP
P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro5 10-pin connector are shown in the fiaure below.

GND +——>

-« TCK/sCK |1 2

—» TDO/MISO | 3 4 | PROG_MODE —
- TMS/SS 5| 6 | VITAG/VSPI #—
-+ VPUMP [ 7 8 | TRSTB —
4— TDI/MOSI |9 10| GND —>

Figure 20 - FlashPro5 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 5 - FlashPro5 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK/SCK JTAG clock; SPI clock
TDI/SDI JTAG data input to device; SPI MOSI
TDO/SDO JTAG data output from device; SPI MISO
TMS/SS# JTAG mode select; SPI Chip Select
nTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during programming
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

FlashPro4

The FlashPro4 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro4 unitis a 2x5, RA male Header connector, which is manufactured by AMP and has a manufacturer's
part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-angle
header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10 pin straight header, AMP
P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro4 10-pin connector are shown in the figure below (extracted from
FlashPro4 product specification):

-~ TCK|1 2 |[GND =—
— TDO|3 4 |PROG_MODE ——
-— Tms[s 6 |VITAG =——
e \pump |7 g8 | nTRST —
- TDI|9 10 |[GND <—8n

Figure 21 - FlashPro4 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 6 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during programming
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

FlashPro3

The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro3 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a manufacturer’'s
part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-angle
header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro5/4/3/3X and use the 10 pin straight header,
AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro3 10-pin connector are shown in the figure below (extracted from
FlashPro3 product specification):

-~ TCK|1 2 [GND =~—
—  TD0|3 4 [NfC

*—TMS[S & |VITAG =——
e \pump |7 & |nTRST ——
- TDI|9 10 |[GND <«—8m

Figure 22 - FlashPro3 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 7 - FlashPro3 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
N/C Programmer does not connect to this pin
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

JTAG Switching Characteristics

FlashPro6 Characteristics
Table 8 - JTAG Switching Characteristics for FlashPro6

Description Symbol Min Max Unit
Output Delay from TCK to TDI, TMS TTCKTDI 2 2.2 ns
TDO setup time before TCK rising, VITAG=3.3V TTDOTCK 114 481 ns
TDO setup time before TCK rising, VITAG=1.5V TTDOTCK 10.5 487 ns
TDO Hold time after TCK rising TTCKTDO 0 -
TCK period TTCK 49.4 - ns

FlashPro5/4/3/3X Characteristics
Table 9 - JTAG Switching Characteristics for FlashPro5/4/3/3X

Description Symbol Min Max Unit
Output delay from TCK to TDI, TMS TTCKTDI -2 2 ns
TDO setup time before TCK rising, VJITAG=3.3 TTDOTCK 12 ns
TDO setup time before TCK rising, VJITAG=1.5 TTDOTCK 145 ns
TDO hold time after TCK rising TTCKTDO 0 ns
TCK period TTCK 41.7 10667 ns
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[llustration of the JTAG Switching Characteristics

The figure below is an illustration of the JTAG switching characteristics.

S
X

TCK

TMS, TDI

Trexro —m=

A
- [Tk B

TTDCTCKAP‘

TrckToo—m
Figure 23 - JTAG Switching Characteristics
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FlashPro Express Reference

FlashPro Express Start Page

The FlashPro Express Start Page is the first page to show when the tool starts up. This page provides the
interface for loading a project into the tool by either navigating to the project location, or clicking on one of the
recently opened projects.

FlashPro Express Project Menu

Command

Function

Create Job Project from
Programming Job

New job project folder with programming job name will be created at
the specified location.

Open Job Project

Loads a job project into the tool by reading the information in user
specified .pro file.

Close Job Project

Closes the current job project

Save Job Project

Saves the current job project

Set Log File

Sets the location of the Log file to your specified location.

Export Log File

Exports the Log file to your specified location.

Execute Script

Runs your specified Tcl script.

Export Script File

Exports all commands run in this session to your specified path as a
Tcl script

Exit

Exits FlashPro Express

FlashPro Express Edit Menu

Command

Function

Clear Log Window

Clears the Log window

FlashPro Express View Menu

The View menu shows or hides the FlashPro Express GUI elements.

Command

Function

Log Window

Shows/hides the Log window
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FlashPro Express Tools Menu

Command Function

Programmer Opens the Programmer Settings dialog box; enables you to set options for all types of
Settings supported Microsemi programmers

Run Runs the current Programming Action.

FlashPro Express Help Menu

Command Function
Help Topics Opens the help
Microsemi Technical Opens the Microsemi technical support site.
Support
Microsemi Web Site Opens the Microsemi website in your default browser
User Guide Opens the FlashPro Express User Guide.
Check for Software Updates | Checks for software updates (works only if you are connected to the
internet)
About FlashPro Express Lists the FlashPro Express release information

FlashPro Express Log Window and Status Bar

FlashPro Express Log Window

The FlashPro Express log window shows status messages for user activity. Click on the appropriate tab
(Messages, Errors, Warning, Info) to filter messages by type.

e Use the right-click menu to copy text, clear the log, and scroll thelog.
e Use the def variable LOG_WINDOW_BUFFER_SIZE to set the buffer size.
e Use the View menu to show or hide the Log window.

FlashPro Express Status Bar
The Status Bar at the bottom displays the status of the load project action.
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Contacting Microsemi

Microsemi SoC Products Group Headquarters

Microsemi Corporation is a supplier of innovative programmable logic solutions, including field-programmable
gate arrays (FPGASs) based on antifuse and flash technologies, high-performance intellectual property (IP) cores,
software development tools, and design services targeted for the high-speed communications, application-specific
integrated circuit (ASIC) replacement, and radiation-tolerant markets.

Address: Microsemi SoC Products Group
3870 North First Street
San Jose, CA 95134

Phone: 408-643-6000

Contact Information
For the most up-to-date contact information, check the Microsemi Home Page.
Contact information for FPGAs & SoCs can be found at the FPGAs and SoCs Support Page
If you do not have internet access, the following information was accurate at the time of publication:

e Technical Support
e Web: https://soc.microsemi.com/mycases
e Phone (NA): 800.262.1060
e Phone (Int'l): +1 650.313.4460
e Email: soc_tech@microsemi.com
e Customer (non-technical) Support
e Phone: +1 650.318.2470
e Email: customer.service@microsemi.com
e Sales Support

e For pricing, order status and lead time information for all Microsemi SoC products, contact your.
Microsemi Sales Representative

e Technical Support for RH and RT FPGAs that are regulated by International Traffic in Arms Regulations
(ITAR)

e Phone (NA): 888.988.ITAR
e Phone (Int'l): +1 650.318.4900
e Email: soc_tech_itar@microsemi.com

Regulatory and Compliance Information

EU Declaration of Conformity:

This product complies with Directive 2011/65/EU of the European Parliament and of the Council of 8 June 2011
on the restriction of the use of certain hazardous substances in electrical and electronic equipment.

To view the Declaration of Conformity in English:
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&qid=131772
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Non-English:
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&qid=131748

Markings:

c € This product complies with 2004/108/EC, Electromagnetic Compatibility (EMC) Directive

For Korea:
Type of Equipment User’s Guide
0] 717l YF&Ad) TEXIHEZ|7|2M T
Ag 7|7

OiXt EE= AHEXAR= O & F2I5HAIZ] it
0o, 7hE2le] XG0 A8l AEs SHER

sL|C}

(HFE2 LSS5

Class A Equipment This  equipment is  Industrial (Class  A)
(Industrial Broadcasting & clectromagnetic wave suitability equipment and
Communication Equipment) | seller or user should take notice of it, and this
equipment is to be used in the places except for home.
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